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EDIUS 6.5 Tricks
Posted by suchart - 2012/12/15 12:10
_____________________________________

EDIUS 6.5 ออกมาได้เกือบปีแล้ว ช่วงแรกการใช้งานก็ยังมีติด ๆ ขัด ๆ อยู่บ้าง แต่ทาง Grass
Valley ก็มีการแก้ไขและปรับปรุงอย่างรวดเร็วจนถึงตอนนี้ก็อัปเดตมาเป็นเวอร์ชัน 6.54 แล้ว 

จากการทดลองใช้งานมาระยะหนึ่งก็พบว่า EDIUS
มีอะไรซุกซ่อนอยู่หลายอย่างที่บางคนอาจไม่เคยรู้มาก่อน จริง ๆ
แล้วแล้วทุกอย่างก็อยู่ในคู่มือของ EDIUS นั่นแหละ
แต่เราไม่ค่อยจะได้อ่านกันอย่างละเอียด เมื่อมีคนไปเจอเข้าและเห็นว่ามีประโยชน์
ช่วยให้ทำงานได้สะดวก ก็บอกต่อ ๆ กันในฟอรัม เว็บบอร์ด หรือเฟสบุ๊ก บางคนก็เสียสละทำเป็น
Tutorial ไว้ใน Youtube ก็มี แต่ทั้งหลายทั้งปวงก็มักเป็นภาษาอังกฤษเสียส่วนใหญ่
ช่วงนี้พอมีเวลาก็เลยคิดว่าจะรวบรวมเรื่องเหล่านี้ไว้ที่ฟอรั่มของ DVM
เผื่อเป็นแหล่งอ้างอิงให้กับตัวเอง และอาจเผื่อแผ่ให้กับผู้ใช้ EDIUS
ในบ้านเราได้อีกด้วย  

เวอร์ชันที่ใช้อ้างอิงจะเป็นเวอร์ชัน 6.52 เป็นหลัก แต่เกือบทั้งหมดก็จะใช้ได้กับ 6.50
และ 6.51 ด้วย บางเรื่องสามารถใช้ได้ตั้งแต่เวอร์ชัน 4.0 เป็นต้นมา  

เนื้อหาคงไม่ได้จัดเรียงหมวดหมู่ เอาเป็นว่านึกอะไรออกก็จะเขียนไปเรื่อย ๆ
ตั้งแต่เรื่องง่าย ๆ อย่างเช่น ปุ่มลัด (Shortcut) ที่มีประโยชน์ เทคนิคการทำงาน
การแก้ปัญหา การใช้งานร่วมกับโปรแกรมหรือโปรแกรมเสริมอื่น ๆ เป็นต้น

============================================================================

Re:EDIUS 6.5 Tricks
Posted by suchart - 2012/12/15 12:31
_____________________________________

จัดคลิปบนไทม์ไลน์ให้อยู่ในหน้าเดียว 

เวลาที่เราวางคลิปหรือดูคลิปบนไทม์ไลน์ บางครั้งคลิปที่วางจะเรียงติดต่อกันยาวมาก
ต้องเสียเวลา scroll เลื่อนไปดูส่วนอื่น ๆ ในทางกลับกัน ตอนเริ่มวางคลิปใหม่ ๆ
อาจจะตั้งสเกลไว้ใหญ่จนทำให้คลิปที่วางลงไปมีขนาดเล็กมาก  

ในโปรแกรม Premiere จะมีปุ่มลัด ""
(Backslash)เพื่อซูมหรือจัดสเกลให้คลิปที่อยู่บนไทม์ไลน์มาแสดงพอดีในหนึ่งหน้า
เพื่อจะได้ดูภาพรวมของงานตัดต่อ
หรือเพื่อค้นหาหรือกระโดดไปยังตำแหน่งที่ต้องการได้อย่างรวดเร็ว EDIUS
ก็ทำแบบนี้ได้เหมือนกัน โดยใช้ปุ่มลัด Ctrl-0 (กด Ctrl บนแป้นพิมพ์พร้อมกับเลขศูนย์)

============================================================================

Re:EDIUS 6.5 Tricks
Posted by suchart - 2012/12/15 12:52
_____________________________________

ใส่ Default Transition อย่างรวดเร็ว 
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Default Transition
หมายถึงเอฟเฟ็กต์เชื่อมคลิปที่เลือกไว้ล่วงหน้าแล้วสำหรับคำสั่งที่ทำงานอัตโนมัติบางคำ
สั่ง ปกติ Defualt Transition จะเป็น Cross Dissolve สังเกตได้จากจะมีอักษร D เล็ก ๆ
อยู่มุมบนขวาของไอคอนของ Cross Dissolve 

เราสามารถเปลี่ยน Defualt Transition ไปเป็นตัวอื่นได้
โดยคลิกขวาที่ไอคอนของเอฟเฟ็กต์ที่ต้องการตั้งให้เป็น Default แล้วเลือก Set As Default
Transition  

การใส่ทรานซิชันแบบพื้นฐานนิยมใช้วิธีลากทรานซิชันจากพาเล็ต Effect
มาวางตรงรอยต่อระหว่างคลิป แต่ EDIUS มีวิธีที่ง่ายกว่าโดย 

- เลื่อนเส้นตัดต่อ (timeline cursor)ไปที่รอยต่อ 
- กดแป้นพิมพ์ Atl ตามด้วยเลขระยะเวลาของเอฟเฟ็กต์ เช่น Alt-3 หมายถึงให้นำ Default Transition
มาใส่ให้กับคลิปทั้งสอง ยาว 3 วินาที 

* แทร็กที่จะวางเอฟเฟ็กต์ต้องถูกเลือกไว้ก่อน (คลิกให้หัวแทร็กนั้นเป็นสีเทา) 
* คลิปทั้งสองควรมีพื้นที่เผื่อ หรือกำหนดจุด In point/Out point ไว้แล้ว

============================================================================

Re:EDIUS 6.5 Tricks
Posted by suchart - 2012/12/18 06:43
_____________________________________

ปรับเล็ม (Trim) เฉพาะภาพหรือเสียง 

ปกติการปรับเล็มคลิปบนไทม์ไลน์มันจะทำทั้งภาพและเสียงพร้อมกัน
ถ้ายากทำเฉพาะภาพหรือเสียงจะต้อง Unlink
คลิปนั้นให้ภาพและเสียงหลุดจากกันก่อนโดยคลิกขวาที่คลิปนั้นแล้วใช้คำสั่ง Link/Group ->
Unlink หรือกด ATL-Y จากแป้นพิมพ์ 

วิธีที่สะดวกกว่าก็คือ กดแป้น Atl แล้วไปคลิกที่รอยต่อคลิปส่วนที่เป็นภาพ หรือ เสียง
จะเกิดเป็นแถบสว่างขึ้นเฉพาะภาพหรือเสียงที่คลิกไว้เท่านั้น จากนั้นให้ปล่อยแป้น Atl ออก
แล้วทำการคลิกลากแถบสว่างตามปกติ จะเห็นว่ามันจะปรับเล็มได้เฉพาะส่วนที่สว่างเท่านั้น 

http://www.dvm-mag.com/images/forum/jcut.jpg 

อีกวิธีหนึ่งก็คือ คลิกที่ไอคอน Set Group/Link Mode ใต้ชื่อโปรเจ็กต์ของไทม์ไลน์
ไอคอนจะมีเส้นพาดแสดงการยกเลิก Link Mode จากนั้นก็คลิกไปที่รอยต่อคลิป
แถบสว่างจะแสดงเฉพาะส่วนของภาพหรือเสียงที่คลิกเท่านั้น
อย่าลืมยกเลิกโหมดนี้ก่อนกลับไปทำงานตามปกติ 
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ตัดคลิปบนไทม์ไลน์พร้อมกับลบทิ้ง 

ปกติเราจะใช้ปุ่มลัด (shortcut) C ในการตัดคลิปที่ถูกเลือกบนไทม์ไลน์ หรือคลิปใด ๆ
บนลู่ที่ถูกเลือกที่ตำแหน่งเส้นเคอร์เซอร์พาดอยู่ เมื่อตัดแล้วคลิปจะแบ่งเป็นสองส่วน
คลิปด้านหลังจะถูกเลือกโดยอัตโนมัติ (ในเวอร์ชันก่อน คลิปด้านหน้าจะถูกเลือกแทน)
เราสามารถกดปุ่ม Delete เพื่อลบทิ้งคลิปที่ถูกเลือกนี้ได้ทันที
แต่กรณีที่เราต้องการลบทิ้งคลิปที่อยู่อีกด้านหนึ่งแทน
เราจะต้องเข้าไปคลิกเลือกส่วนนั้นเองเสียก่อน 

EDIUS 6.5 มีวิธีที่ง่ายกว่านั้น เพียงกดปุ่ม N
คลิปจะถูกตัดที่ตำแหน่งเส้นเคอร์เซอร์แล้วลบทิ้งคลิปที่อยู่ด้านหน้า (ทางซ้าย) หรือกด M
คลิปจะถูกตัดที่ตำแหน่งเส้นเคอร์เซอร์แล้วลบทิ้งคลิปที่อยู่ด้านหลัง (ทางขวา) ทันที  

การตัดคลิปโดยใช้ปุ่ม N/M ก็เหมือนกับการกำหนดตำแหน่ง Mark In/Out บนไทม์ไลน์
แต่มีข้อที่ดีกว่าคือ ทรานซิชันช่วงรอยต่อคลิปจะไม่หายไป
จึงไม่ต้องลากทรานซิชันมาวางใหม่ทุกครั้งที่ตัดหรือปรับเล็มคลิป 

* ถ้าต้องการให้ลบส่วนที่ตัดแล้วไม่เกิดช่องว่าง
หรือขยับคลิปที่อยู่ถัดไปมาชิดโดยอัตโนมัติ ต้องเลือกการทำงานแบบ Ripple Mode ด้วย
หรือง่ายกว่าก็คือให้กด Alt พร้อมกับกด M หรือ N
ก็จะลบช่องว่างให้เช่นเดียวกับการตั้งเป็นโหมด Ripple เช่นกัน 
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============================================================================

Re:EDIUS 6.5 Tricks
Posted by suchart - 2012/12/18 07:25
_____________________________________

Home, End, A, S ปุ่มตัดต่อยอดนิยม 

นอกจาก Ctrl-0 เพื่อย่อขยายให้คลิปบนซีเควนซ์มาพอดีจอแล้ว คราวนี้ขอเสนอปุ่มยอดนิยมอีก 4
ปุ่ม ที่ใช้งานประจำสำหรับคอ EDIUS ตัวจริง 

ปุ่ม Home สำหรับกระโดดไปหัวสุดของซีเควนซ์ที่มีคลิปอยู่ 
ปุ่ม End สำหรับกระโดดไปท้ายสุดของซีเควนซ์ที่มีคลิปอยู่ 

ปุ่ม A สำหรับกระโดดไปยังจุดตัดต่อด้านซ้ายของเส้นเคอร์เซอร์ 
ปุ่ม S สำหรับกระโดดไปยังจุดตัดต่อด้านขวาของเส้นเคอร์เซอร์ 

* ทำงานโดยใช้ปุ่มลัดบ่อย ๆ จะดูคล่องตัวและเป็นมืออาชีพขึ้นเยอะเลย

============================================================================

Re:EDIUS 6.5 Tricks
Posted by suchart - 2012/12/18 07:38
_____________________________________

สร้างภาพนิ่งฉับไวในพริบตา 
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เวลาลากเส้นเคอร์เซอร์บนคลิปวิดีโอในไทม์ไลน์ (เรียกว่า scrubbing)
ภาพวิดีโอที่ตำแหน่งนั้น ๆ จะปรากฏขึ้นบนจอ REC ถ้าอยากได้ภาพนั้นให้กด Ctrl-T ทันที
จะได้ภาพนิ่ง (still image) เป็นคลิปอยู่บนพาเล็ตบิน (Bin) ที่เปิดอยู่ พร้อมกับไฟล์นามสกุล
bmp เพื่อให้นำไปใช้งานตามประสงค์ ถ้าอยากรู้ว่าคลิปนั้นบันทึกไว้ที่ไหน ชืออะไร
ก็ใไห้คลิกขวาที่คลิปนั้นแล้วดู Properties 

http://www.dvm-mag.com/images/forum/fileproperties.jpg

============================================================================

Re:EDIUS 6.5 Tricks
Posted by suchart - 2012/12/18 08:00
_____________________________________

เลื่อนคลิปบนไทม์ไลน์ทีละเฟรม 

การเลื่อนคลิปเพื่อจะซิงค์กับคลิปอื่น ๆ อาจจะต้องขยับกันทีละเฟรม
บางคนใช้วิธีซูมไทม์ไลน์ให้สุด (Ctrl-1) หรือขยายสเกลเวลาให้เป็น 1 เฟรม
แล้วค่อยลากคลิปอย่างช้า ๆ  

วันนี้นำเสนอวิธีง่าย ๆ ในการเลื่อนคลิปบนไทม์ไลน์ทีละเฟรมโดย 
- เลือกคลิป หรือกลุ่มคลิปที่ต้องการเลื่อน คลิปที่เลือกจะสว่างขึ้น 
- กด "," (คอมม่า) เพื่อเลื่อนคลิปไปทางซ้ายทีละเฟรม 
    กด "." (จุด)เพื่อเลื่อนคลิปไปทางขวาทีละเฟรม

============================================================================

Re:EDIUS 6.5 Tricks
Posted by suchart - 2012/12/18 10:50
_____________________________________

เฟดอิน/เฟดเอาต์ ได้อย่างไร 

อะไรที่ง่าย ๆ บางทีก็ดูเหมือนยาก โดยเฉพาะมือใหม่ EDIUS  
สำหรับเวอร์ชัน 6.5 เรามีวิธีเฟดที่ทำภาพจางเข้า/จางออกได้หลายวิธีดังนี้ 

ใช้เอฟเฟ็กต์ Dissolve มาวางที่หัวหรือท้ายคลิปในชั้นของ Mix ขยายความได้ว่า
คลิปเมื่อวางอยู่บนไทม์ไลน์จะมีด้วยกันหลายชั้น ถ้าเป็นลู่ VA จะมี 3 ชั้น คือ
ชั้นบนสุดเป็นภาพ ชั้นที่สองเป็นเสียง และชั้นล่างสุดเป็น Mix หรือส่วนควบคุมความทึบ
(opacity) ของภาพ การวาง Dissolve ให้วางลงในชั้น mix นี้ เราสามารถขยายชั้น mix
ให้ชัดเจนโดยกดสามเหลี่ยม mix ที่บริเวณหัวของลู่ เมื่อวาง Dissolve
แล้วจะปรากฏดังรูปข้างล่าง 
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ปรับความทึบ (Opacity) โดยตรง โดยการขยายชั้น Mix ออกมา แล้วคลิกคำว่า mix
ให้สว่างเพื่อให้เข้าไปควบคุมความทึบได้ คลิกที่เส้นควบคุมความทึบหรือ rubber band
ของคลิปบริเวณที่ต้องการเฟดเริ่มหรือจบจะได้เป็นจุดคีย์เฟรม (ปกติจะมีให้ 2 จุด
หัวและท้ายอยู่แล้ว) ดึงจุดคีย์เฟรมด้านปลายสุดลงมา ภาพก็จะเฟดอิน หรือเฟดเอาต์
ตามเส้นควบคุมความทึบนี้ 
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ใส่ปุ่ม fade in/out บนไทม์ไลน์ โดยไปที่เมนูคำสั่ง Settings->User Settings แล้วไปหัวข้อ User
Interface คลิก Button เลือกหัวข้อ Timeline และ Category เป็น All หาปุ่มที่ต้องการ ในที่นี้คือ
Fade-in และ Fade-out เลือกปุ่มที่ต้องการแล้วคลิกเครื่องหมาย >>
เพื่อส่งปุ่มนั้นไปยังช่อง Current Button ดังรูปข้างล่าง เมือกด OK
บนไทม์ไลน์ของเราก็จะมีปุ่ม Fade-in/Out ให้ใช้งาน 
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การใช้งาน ให้คลิกเลือกคลิปหรือลู่ที่ต้องการใส่ Fade-in/out ให้กับคลิป
จากนั้นเลื่อนไทม์ไลน์เคอร์เซอร์ไปพาดคลิปให้ได้ระยะเฟดจากหัวหรือท้ายที่ต้องการ
จากนั้นกดปุ่ม Fade-in หรือ Fade-out ก็จะได้เฟดตามต้องการ ข้อสังเกต
การสร้างเฟดวิธีนี้จะเป็นแบบเดียวกับวิธีปรับความทึบแบบที่ 2 นั่นเอง 

http://www.dvm-mag.com/images/forum/fadebybutton.jpg 

============================================================================

Re:EDIUS 6.5 Tricks
Posted by suchart - 2012/12/18 11:16
_____________________________________

เลือกคลิปบนไทม์ไลน์ครั้งละมาก ๆ 

ปกติอยากเลือกคลิปไหน ก็คลิกไปที่คลิปนั้น ถ้าคลิกไปที่คลิปอื่นอีก
คลิปเดิมก็จะถูกยกเลิก ถ้าอยากจะให้เลือกได้หลายคลิปมีวิธีดังนี้ 

กด Ctrl ขณะคลิกเลือกคลิป จะเพิ่ม (หรือลดถ้าคลิปนั้นเลือกไว้แล้ว)
คลิปที่ถูกเลือกเข้ามาเรื่อย ๆ 
กด Shift
จะเลือกคลิปทุกคลิปในลู่เดียวกันตั้งแต่คลิปที่เลือกครั้งหลังกับการคลิกเลือกครั้งสุดท
้าย 
กด Ctrl-A จะเลือกทุกคลิปบนแทร็กที่เลือกไว้  
กด Shift-A จะเลือกคลิปทั้งหมดบนไทม์ไลน์ 
กด Shift-END ถ้าต้องการเลือกคลิปทั้งหมดบนไทม์ไลน์ตั้งแต่ ไทม์ไลน์เคอร์เซอร์เป็นต้นไป 
กด Ctrl-END จะเลือกทุกคลิปตั้งแต่ไทม์ไลน์เคอร์เซอร์ไปจนจบเฉพาะลู่ที่เลือกไว้เท่านั้น 
คลิกเมาส์แล้วกวาดครอบเป็นสี่เหลี่ยม คลิปทุกคลิปที่อยู่ภายในกรอบ
รวมทั้งที่ถูกเส้นกรอบพาดทับ จะถูกเลือกท้งหมด 

**กรณีที่ต้องการย้ายคลิปและคลิปที่อยู่ด้านหลังทั้งหมด ไม่จำเป็นต้องเลือกคลิปทั้งหมด
ให้คลิกเลือกเฉพาะคลิปตัวนั้นแล้ว กดปุ่ม Alt+Shift
พร้อมกันก็จะสามารถลากคลิปนั้นพร้อมกับคลิปด้านหลังทั้งหมดไปพร้อมกันได้

============================================================================

Re:EDIUS 6.5 Tricks
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Posted by suchart - 2013/01/29 07:56
_____________________________________

เร็นเดอร์เร็วสุด ๆ ด้วยฮาร์ดแวร์ 

บางคนสงสัยว่า EDIUS ทำงานเรียลไทม์ไม่ใช่หรือแล้วจะเร็นเดอร์ทำไม 
ถูกต้องครับ EDIUS ทำงานบนไทม์ไลน์เป็นเรียลไทม์เอาต์พุต ไม่ต้องเร็นเดอร์ก็ได้
เว้นแต่เราจะให้งานเกินกำลังของมัน เช่นซ้อนภาพ HD กันหลาย ๆ ชั้น 

แต่กรณีที่เรา Export โปรเจ็กต์ไปเป็นฟอร์แมตอื่น เช่น ส่งไปเป็นไฟล์ดีวีดี บลูเรย์
หรือพวกตระกลู MP4 หรือ H.264 ทั้งหลาย กรณีนี้ไม่ว่าระบบไหน ๆ
ในโลกก็ต้องมีการเร็นเดอร์ครับ 

แต่เดิม EDIUS ก็ทำงานด้วยซอฟต์แวร์ล้วน ๆ
อยากทำงานเร็วก็ต้องใช้ซีพียูที่มีประสิทธิภาพสูง แต่ปัจจุบันนอกจากซีพูยูหลักแล้ว
ก็ยังมีการ์ดแสดงผล หรือที่นิยมเรียกกันว่า กราฟิกการ์ดก็สามารถนำมาช่วยการเร็นเดอร์ได้
จึงเป็นที่มาของ GPU Effect ซึ่งมีทั้งที่ให้มาเป็นทรานซิชันมาตรฐานของ EDIUS
หรือที่เป็นเอฟเฟ็กต์ติดตั้งเพิ่มเติมจากผู้ผลิตรายอื่น แต่สำหรับผู้ที่ไม่ใช้ GPU
Effect เลย การใช้การ์ดแสดงผลแรง ๆ และแน่นอนแพง ๆ ด้วย
ก็คงไม่ค่อยจะได้ประโยชน์สักเท่าไหร่ 

แต่หลังจากการเปิดตัวซีพียูรุ่นใหม่ของอินเทล ตั้งแต่ Sandy Bridge เป็นต้นมา
(รุ่นปัจจุบันเป็น Ivy Bridge) อินเทลได้นำเทคโนโลยีที่เรียกว่า QuickSync
มาใส่ลงในส่วนของภาคแสดงผล (HD Series) ของซีพียูด้วย เจ้า QuickSync
นี้ก็คือชุดคำสั่งหรือความสามารถในการเข้ารหัสภาพวิดีโอ โดยเฉพาะในฟอร์แมต MPEG4 และ
H.264 เป็นหลัก Grass Valley จึงได้โอกาสดึงเอาความสามารถนี้มาใช้งานใน EDIUS เสียเลย
โดยเริ่มตั้งแต่เวอร์ชัน 6.0 เป็นต้นมา ผลปรากฏว่า ประสิทธิภาพของการเร็นเดอร์ฟอร์แมต
MPEG4/H.264 เร็วขึ้นอย่างก้าวกระโดด 

แต่เป็นที่น่าเสียดายว่าผู้ใช้ EDIUS
หลายคนไม่ค่อยจะเชื่อมือภาคแสดงผลของอินเทลที่แถมมาให้
จึงไปซื้อการ์ดจอแยกมาติดตั้งเองแล้วทิ้งกราฟิกของอินเทลไว้เปล่า ๆ
บางรายไม่แค่ไม่ติดตั้งไดรเวอร์ให้มันเท่านั้นแต่ยังปิดมันไว้ (disable) ไม่ให้ทำงานด้วย
ทำให้พลาดโอกาสในการสร้างประสิทธิภาพในการเร็นเดอร์งานแบบเร็วสุด ๆ ไปอย่างน่าเสียดาย 

อยากให้ดูตัวอย่างการทดสอบการเร็นเดอร์โปรเจ็กต์ HD ความยาว 2 นาที 
จากรูป ใช้คำสั่ง File -> Export -> Prin to File เลือกพรีเซ็ตเป็น H.264/AVC และ Exporter เป็น
Blu-ray 

http://www.dvm-mag.com/images/forum/H264Export1.JPG 

เมื่อกดปุ่ม Export หน้าต่าง Blu-ray จะเปิดขึ้นมาให้เราใส่ค่าพารามิเตอร์ต่าง ๆ
ให้สังเกตบรรทัดสุดท้าย ถ้าระบบของเรา เปิด QuickSync ได้ จะมี Use Hardware Encoder
ขึ้นมาให้เราติ๊ก ในที่นี้ผมจะลองติ๊กออกก่อน  

http://www.dvm-mag.com/images/forum/H264Export2.JPG 

หลังจากตั้งชื่อไฟล์แล้วกด Save เลย สถานะการทำงานจะแสดงออกมา
สักครู่จะประมาณเวลาการทำงานให้เห็น 

http://www.dvm-mag.com/images/forum/H264Export3.JPG 
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ตัวเลขที่ได้คือ 4 นาทีครึ่ง (278 วินาที) 

จากนั้นกลับไป Export ใหม่อีกที คราวนี้ ติ๊กให้มีเครื่องหมายถูกที่ Use Hardware Encoder
ด้วย ลองมาดูตัวเลขใหม่ 

http://www.dvm-mag.com/images/forum/H264Export4.JPG 

จะเห็นว่า ตัวเลขใหม่ใช้เวลาเพียง 45 วินาที เท่านั้นเอง คิดเป็นอัตราส่วนได้ 278/45 = 6.2
เท่า เลยทีเดียว ดีไหม? สำหรับท่านที่ใช้ GPU Effect และมีการ์ดกราฟิกส์เร็ว ๆ ติดตั้งด้วย
ก็จะเห็นความเร็วที่เหนือขึ้นไปอีก 

อยากใช้บ้าง จะทำอย่างไร 
1. ใช้ซีพียู Intel ตระกูล Sandy หรือ Ivy Bridge เช่น i7-3770 
2. ใช้เมนบอร์ดที่ใช้ชิปเซ็ตที่สนับสนุน QuickSync เช่น H77 
3. อย่าลืม Enable กราฟิกส์บนเมนบอร์ด (iGPU) พร้อมติดตั้งไดร์เวอร์ของอินเทลให้เรียบร้อย
แน่นอน OS ต้องเป็น Windows 7 ขึ้นไปด้วย 
4.
ถ้ามีกราฟิกตัวอื่นติดตั้งไว้ด้วยก็ให้ลงไดรเวอร์ของกราฟิกส์นั้นให้เรียบร้อยด้วยเช่นก
ัน 
5. สำคัญ ต้องต่อจอเข้ากับพอร์ตกราฟิกส์บนเมนบอร์ดด้วย ถ้าจะใช้ GPU
ของการ์ดที่ติดตั้งเพิ่มเติมด้วยก็จะต้องมีอีกจอหนึ่งต่อเข้ากับการ์ดนี้
จึงจะใช้ฮาร์ดแวร์ทั้งสองอย่างช่วยกันทำงานได้ 
6. ถ้าทุกอย่างเรียบร้อย  Use Hardware Encoder ดังกล่าวมาแล้วต้องแสดงออกมาให้เราติ๊กได้
(ปกติถ้าพบ QuickSync EDIUS จะติ๊กให้อยู่แล้ว) 

แค่นี้เราก็สามารถเร็นเดอร์ได้ เร็วกว่าเวลาจริงในโปรเจ็กต์สองเท่าเป็นอย่างน้อย  

ขอบคุณ Intel ขอบคุณ EDIUS ขอให้มีความสุขกับการเร็นเดอร์นะครับ 

* ล่าสุด ได้นำโปรเจ็กต์มาทดลองเร็นเดอร์จริง ๆ ไม่ใช่แค่ให้ EDIUS ประมาณเวลา
ตัวโปรเจ็กต์ใช้คลิป P2 HD วางไปบนไทม์ไทน์แบบตัดชนยาว 3 นาที ไม่มีเอฟเฟ็กต์ใด ๆ เลือก
Export เป็น Blu-ray พารามิเตอร์อื่น ๆ ใช้ของเดิม เว้นแต่ การเข้ารหัสเป็นแบบ VBR
และคุณภาพระดับ Super Fine โดยใช้ซีพียู i7 3770 ความเร็ว 3.4Ghz หน่วยความจำ 16GB 

ผลปรากฎว่า ไม่ใช้ Hardware Encoder ใช้เวลา 16.03 นาที 
ใช้ Hardware Encoder ใช้เวลาเพียง 1.02 นาที  
นั่นคือ เร็วขึ้นถึง 16 เท่า ทีเดียว 

ลองกลับไปสำรวจ ใครที่มีกราฟิกส์อินเทลติดบอร์ดแล้วไม่ได้ใช้ รีบนำกลับมาใช้เลย
รับรองคุ้มจริง ๆ

============================================================================

Re:EDIUS 6.5 Tricks
Posted by suchart - 2013/02/04 08:25
_____________________________________

Full Screen Preview 

งานตัดต่อวิดีโอนั้น นิยมต่อทีวีมอนิเตอร์เข้ากับระบบตัดต่ออีกตัวหนึ่ง
เพื่อให้เห็นผลงานได้แบบเต็มจอแทนที่จะเป็นกรอบเล็ก ๆ อยูในโปรแกรมตัดต่อวิดีโอ
ยิ่งกว่านั้นเป็นที่ทราบกันดีว่า
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ระบบสีและการแสดงภาพของจอคอมพิวเตอร์กับจอโทรทัศน์นั้นต่างกัน
คอมพิวเตอร์ใฃ้ปริภูมิสีแบบ RGB กราดภาพแบบนอนอินเทอร์เลสเป็นหลัก
ส่วนโทรทัศน์ใช้ปริภูมิสีแบบ YUV กราดภาพแบบอินเทอร์เลสเป็นส่วนใหญ่
การเช็คภาพจากจอคอมพิวเตอร์อย่างเดียวจึงมีโอกาสผิดพลาดได้ 

แต่การจะต่อทีวีมอนิเตอร์ได้
คอมพิวเตอร์ที่ใช้ในการตัดต่อของเราจะต้องมีฮาร์ดแวร์เพิ่มเติม
อาจจะอยู่ในรูปของการ์ดตัดต่อวิดีโอ หรือกล่องแปลงสัญญาณภายนอกก็ได้
ถ้าท่านยังไม่มีฮาร์ดแวร์เหล่านี้ละ EDIUS 6 สามารถช่วยท่านได้ 

คำสั่ง View -> Full Screen Preview
จะให้เราเลือกจอคอมพิวเตอร์ที่ต่ออยู่ไปใช้แสดงภาพวิดีโอแบบเต็มจอได้ ดังรูป 
เราอาจสร้างปุ่มลัดเพื่อให้การเรียกใช้คำสั่งนี้สะดวกขึ้น จากรูปตัวอย่าง กำหนดให้ ปุ่ม
F2 เป็นคำสั่ง เข้าหรือออกจากการพรีวิวแบบเต็มจอพร้อมกันทุกจอ (All) 

http://www.dvm-mag.com/images/forum/FSP1.JPG 

สำหรับท่านที่ต่อจอคอมพิวเตอร์ไว้เพียงตัวเดียวอาจจะลำบากสักหน่อย
เพราะขณะพรีวิวแบบเต็มจอ เราจะไปใช้งานหน้าจอปกติไม่ได้ จะต้องออกจากโหมดนี้เสียก่อน
แต่สำหรับท่านที่ต่อจอไว้  2 จอหรือมากกว่า
ก็สามารถเลือกจอที่ไม่ได้งานในช่วงนั้นเป็นจอแสดงผลแบบเต็มจอได้ 

อย่างไรก็ตาม ไม่เพียงเฉพาะการพรีวิวจากไทม์ไลน์เท่านั้นที่สามารถทำแบบเต็มจอได้เพราะ
EDIUS ให้ท่านเลือกการพรีวิวได้ 2 แบบคือ 

Player/Multicam Source ใช้พรีวิวงานที่แสดงบนจอ Player (จอซ้ายมือเมื่ออยู่ในโหมดสองจอ หรือ
Dual Mode) 
Recoder/Selected camera ใช้พรีวิวงานที่แสดงบนจอ Recoder (จอขวามือเมื่ออยู่ในโหมดสองจอ
หรือ Dual Mode) 

เราสามารถกำหนดได้ว่าจะให้จอไหนทำงานแบบไหน หรือไม่ให้พรีวิวแบบเต็มจอเลย หรือให้ EDIUS
เลือกแบบอัตโนมัติได้ โดยไปที่คำสั่ง Settings -> User Settings จากนั้นคลิก Monitor ในหัวข้อ
Preview 

http://www.dvm-mag.com/images/forum/FSP2.JPG 

จากรูป  
จอที่ 1 กำหนดไม่ให้ใช้สำหรับการพรีวิวแบบเต็มจอ 
จอที่ 2 ให้พรีวิวแบบเต็มจอสำหรับภาพใด ๆ ที่แสดงอยู่บนจอ Player 
จอที่ 3 กำลังเลือกว่า จะให้ทำงานแบบใด 

หมายเหตุเมนบอร์ดที่ใช้ภาคแสดงผลที่อยู่บนชิปอินเทล Core i7 ถึงแม้จะมีพอร์ตต่อจอให้ 3
ช่อง (VGA, DVI, HDMI) แต่จะใช้งานได้พร้อมกันเพียง 2 ช่องเท่านั้น แม้ว่า Windows
จะมองเห็นทั้ง 3 จอก็ตาม เมนบอร์ดที่สามารถใช้งานได้ 3
จอพร้อมกันจะต้องเป็นรุ่นที่มีช่องต่อจอแบบ DisplayPort อย่างน้อย 2 ช่อง และแบบอื่น ๆ 
(VGA, DVI, HDMI) อีก 1 หรือ 2 ช่อง จึงจะต่อใช้งาน 3 จอพร้อมกันได้
สำหรับท่านที่ไม่มีเมนบอร์ดดังกล่าว ให้หาการ์ดจอเล็ก ๆ
มาติดตั้งเพิ่มเติมจะสะดวกและประหยัดกว่า โปรแกรม EDIUS
ไม่ได้ใช้ความสามารถของการ์ดจอที่ติดตั้งเพิ่มเติมเหล่านี้มากนัก
เว้นแต่ท่านที่ชอบใช้งาน GPU Effect เท่านั้นที่ควรจะหาการ์ดจอประสิทธิภาพสูง ๆ มาใช้

============================================================================
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Re:EDIUS 6.5 Tricks
Posted by suchart - 2013/08/27 07:11
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ลบ Recent Projects Items 

บางครั้งเราอาจรำคาญที่เห็นรายการโปรเจ็กต์เก่าโผล่ออกมาให้เลือกทั้ง ๆ
ที่โปรเจ็กต์นั้นเราไม่ได้ใช้แล้ว หรือบางทีอาจลบทิ้งไปแล้วด้วยซ้ำ 

จริง ๆ เมื่อเราเปิดโปรเจ็กต์ใหม่ไปเรื่อย ๆ โปรเจ็กต์เก่า ๆ ที่ไม่ได้ใช้ก็จะค่อย ๆ
ถูกแทนที่และหายไปในที่สุดอยู่แล้ว แต่สำหรับคนใจร้อน
วันนี้จะแนะนำวิธีเอารายการเหล่านี้ออกไปอย่างไม่เป็นทางการ
แต่ผู้ที่จะทำต้องระมัดระวังเป็นพิเศษมิฉะนั้นอาจจะทำให้โปรแกรมมีปัญหาได้ถ้าเกิดไปลบผ
ิดตำแหน่ง ซึ่งผู้ทำต้องเสี่ยงกันเอาเอง แต่ผมได้ทดลองทำตามแล้วยืนยันว่าใช้ได้ 

อันดับแรกให้ไปค้นหาไฟล์ชื่อ CurrentSettings.esp มา วิธีที่ง่ายที่สุดก็คือการใช้ Search
ของ Windows นั้นแหละ โดยคลิกไปที่ปุ่ม Start แล้วพิมพ์ชื่อไฟล์นี้ลงในช่องค้นหา
ถ้ายังหาไม่เจอให้คลิกที่ปุ่ม See more results
แล้วพิมพ์ชื่อไฟล์นี้อีกครั้งลงในช่องค้นหาที่มุมขวาบนตามรูป ถ้ามีโปรแกรม EDIUS
ติดตั้งอยู่ มันจะต้องหาเจอ 

http://www.dvm-mag.com/images/forum/Recent Project1.JPG 

คลิกขวาไฟล์ที่พบเพื่อเปิดด้วยโปรแกรม Notepad แล้วหาหัวข้อ  ให้ลบรายการที่อยู่ระหว่าง 
จนถึง  ออก หรือจะเลือกตัดและจัดเรียงลำดับใหม่ (แก้ตัวเลขลำด้บหน้ารายการด้วย)
ตามต้องการแล้วสั่ง File>Save ทับของเดิมไป 

http://www.dvm-mag.com/images/forum/Recent Project2.JPG 

เมื่อเปิด EDIUS ขึ้นมาใหม่จะเห็นว่ารายการ Recent Project
จะเปลี่ยนไปตามที่เราได้แก้ไขไว้ 

* ในเวอร์ชัน 7 สามารถคลิกขวาที่เมาต์บนพื้นที่ของรายการโปรเจ็กต์เก่า
แล้วเลือกล้างประวัติ หรือประวัติทั้งหมดทิ้งได้เลย 

http://www.dvm-mag.com/images/forum/Clearlist.JPG

============================================================================

Re:EDIUS 6.5 Tricks
Posted by suchart - 2013/09/10 03:51
_____________________________________

Restore Offline Clips 

หลังจากการใช้งาน EDIUS สักระยะหนึ่ง คุณอาจจะมีการโยกย้ายโปรเจ็กต์หรือคลิป
ทั้งที่ตั้งใจและไม่ตั้งใจ จนทำให้เมื่อเปิดโปรเจ็กต์ออกมาอีกครั้งแล้ว EDIUS
หาคลิปที่ใช้อยู่ไม่เจอ กลายเป็นออฟไลน์คลิป (offline clips)
ซึ่งจะเห็นรูปคลิปบนไทม์ไลน์มีลายเส้นเฉียงพาดบนตัวคลิปนั้น
และเห็นเครื่องหมายขาดที่ตัวคลิปในหน้าต่างบิน (bin) 
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http://www.dvm-mag.com/images/forum/res_0_3.JPG 

http://www.dvm-mag.com/images/forum/res_0_1.JPG 

วิธีเชื่อมออฟไลน์คลิปไปยังคลิปเดิม ทำได้ง่าย ๆ โดยดับเบิลคลิกที่คลิปนั้น
จะทำบนไทม์ไลน์หรือบนหน้าต่างบินก็ได้ หน้าต่าง Transfer and Restore Clips จะปรากฏออกมา
กรณีที่คลิปนั้นมีแบบความละเอียดต่ำ (Proxy) ด้วย ก็จะปรากฏในรายการ Lost file ด้วยเช่นกัน
ให้ดับเบิลคลิกบนชื่อคลิปที่ต้องการบนหน้าต่างนี้อีกครั้ง หน้าต่าง Open
จะเปิดออกมาให้เราเลือกไฟล์ที่ต้องการเชื่อมต่อซึ่งต้องมีชื่อตรงกัน
ถ้าต้องการบอกแค่โฟลเดอร์ ให้คลิกเลือก Relink (select folder) ในช่อง Restoration Method แทน
โปรแกรมจะเข้าไปหาไฟล์ที่มีชื่อตรงกันให้เอง 

http://www.dvm-mag.com/images/forum/res_1_1.JPG 

แต่ถ้าต้องการเชื่อมไปยังไฟล์ใหม่ที่มีชื่อต่างไปจากเดิม ให้ปลดเครื่องหมายถูกข้างหน้า
link only files that perfectly match ออกเสียก่อน 

http://www.dvm-mag.com/images/forum/res_2.JPG 

กรณีที่ต้องการเชื่อมไฟล์ออฟไลน์จำนวนมาก ให้ใช้คำสั่ง Restore offline files
ซึ่งเรียกจากเมนูคำสั่ง File>Restore Offline Clip… หรือจากทางเลือกของคำสั่ง Open Project
บนไทม์ไลน์ตามรูปข้างล่างก็ได้  

http://www.dvm-mag.com/images/forum/res_1_2.JPG 

เมื่อเรียกคำสั่งนี้แล้ว EDIUS จะให้เราเลือกวิธีการ Restore ให้เลือกไปที่ Open the clip
restoration dialog… (รายการอื่นจะเลือกไม่ได้ถ้าคลิปไม่ได้มาจากการแคปเจอร์จากเทป)  

http://www.dvm-mag.com/images/forum/res_5.JPG 

ออฟไลน์คลิปทั้งหมดก็จะแสดงรายการออกมาในหน้าต่าง Restore and Transfer Clips
หน้าที่เราก็คือเลือกทุกคลิปที่ต้องการเชื่อมโดยใช้ปุ่ม Ctrl กับ Shift
ช่วยเช่นเดียวกับการเลือกไฟล์หลายไฟล์ใน Windows ปกติ จากนั้นให้กด Relink (select folder)..
ในช่อง Restoration Method ของรายการสุดท้ายที่เลือกเอาไว้ (ทางเลือก select file
จะไม่แสดงออกมาถ้าเลือกคลิปมากกว่า 1 คลิป) 

http://www.dvm-mag.com/images/forum/res_6.JPG 

http://www.dvm-mag.com/images/forum/res_7.JPG 

** ข้อควรระวังก็คือ คลิปที่เลือกจะต้องเป็นชนิดเดียวกัน เช่นเป็น Hires หรือ Proxy
เหมือนกัน มิฉะนั้นจะเชื่อมไม่ได้ คือมีแต่ Do nothing ให้เลือก
วิธีที่สะดวกคือให้คลิปเรียงลำดับใหม่ตามชนิดของคลิป โดยการคลิกที่หัวคอลัมน์ Hires/Proxy
คลิปก็จะแยกกลุ่มออกมา ทำให้เราเลือกคลิปได้สะดวกขึ้น

============================================================================

Re:EDIUS 6.5 Tricks
Posted by suchart - 2014/01/07 06:47
_____________________________________

สวัสดีปีใหม่ 2557 
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ก่อนอื่นต้องขอสวัสดีปีใหม่ 2557 กับผู้ใช้งาน EDIUS ทุกท่าน ขอให้ประสบโชคดี มีความสุข
ทำอะไรก็สำเร็จตามที่มุ่งหวัง มีสุขภาพสมบูรณ์แข็งแรง ห่างไกลจากภยันตรายใด ๆ ทุกประการ 

มีเรื่องที่จะต้องบอกกล่าวกันเล็กน้อยว่า ณ วันที่โพสต์นี้ EDIUS
ได้พัฒนาขึ้นไปเป็นรุ่น 7.21 แล้ว มีสิ่งต่าง ๆ เพิ่มขึ้นมามากมาย เช่นการรองรับ Windows
7/8 แบบ 64 บิต และทำงานแบบ 64 บิตแท้ การสนับสนุนฮาร์ดแวร์ไม่เฉพาะของ Grass Valley เท่านั้น
การปรับปรุงการทำงานร่วมกับ CODEC ใหม่ ๆ ได้มากและรวดเร็วขึ้นเป็นต้น
ดังนั้นหัวข้อต่าง ๆ ที่จะกล่าวถึงตั้งแต่บัดนี้เป็นต้นไปจะใช้ EDIUS 7.21
ในการอ้างอิงเป็นหลัก อย่างไรก็ตามผมก็จะยังโพสต์ต่อในกระทู้ EDIUS 6.5 Tricks เหมือนเดิม
ในกรณีที่หัวข้อนั้น ๆ ยังมีการใช้งานเหมือนกันทั้ง  2 รุ่น
สำหรับเรื่องราวที่เน้นเฉพาะรุ่นที่ 7 ขึ้นไปถ้ามี
จะพิจารณาเปิดเป็นกระทู้ใหม่ในโอกาสต่อไป

============================================================================

Re:EDIUS 6.5 Tricks
Posted by suchart - 2014/01/07 08:41
_____________________________________

วิธีทำ Rate Stretch แบบ Adobe Premiere 

เมื่อไม่นานมานี้ได้พบกับผู้ใช้ EDIUS โดยบังเอิญท่านหนึ่งซึ่งถือว่าเป็น
ซูเปอร์ยูสเซอร์ ก็ว่าได้ เพราะท่านผู้นี้ใช้งาน EDIUS มาตั้งแต่สมัยที่ยังเป็น Storm
EDIT อยู่เลย หลังจากถามไถ่ถึงสารทุกข์สุขดิบกันแล้ว ผมก็ถูกยิงคำถามว่า EDIUS
มีเครื่องมือ Rate Steatch แบบ Premiere ไหม เพราะใช้งานสะดวกดี 
ผมตอบแบบไม่ต้องคิดทันทีว่า ไม่มีครับ แต่ทำแบบนั้นได้แน่ ๆ กลับไปแล้วจะหาวิธีทำให้
แต่ก็ลืมไปเสียสนิท พอนึกขึ้นได้จึงรีบมาเขียนลงในกระทู้ทันที 

ก่อนอื่นมาทบทวนกันก่อนว่า Rate Stretch Tool ใน Premiere คือเครื่องมือปรับอัตราเร็วของคลิป
(ทำภาพช้าหรือเร็ว) บนไทม์ไลน์ โดยการใช้เครื่องมือ Rate Stretch
คลิกลากบริเวณขอบของคลิปบนไทม์ไลน์ให้หดลงหรือยาวขึ้นโดยตรง
การหดลงหรือยาวขึ้นนี้ไม่ได้ทำให้จำนวนเฟรมของภาพมากขึ้นหรือน้อยลงเหมือนกับการปรับ
Mark-in/out ตอนใช้ Select Tool แต่จะเป็นการปรับอัตราเร็วของคลิปแทน (ยาวขึ้นเป็นภาพเล่นช้า
สั้นลงเป็นภาพเล่นเร็ว)
เครื่องมือนี้มักใช้กรณีที่ต้องการแทนช่องว่างบนไทม์ไลน์ด้วยคลิปหนึ่งให้พอดีโดยไม่มีก
ารเพิ่มหรือตัดเฟรมของคลิปนั้น ถ้าไม่มีเครื่องมือนี้เราจะต้องปรับอัตราเร็วของคลิปเอง
เช่น 70% หรือ 135% เพื่อย่อขยายคลิปให้พอดีกับช่องว่างนั้นซึ่งทำไม่ได้ง่าย ๆ  

EDIUS ไม่มีเครื่องมือนี้โดยตรง แต่ทำได้โดยใช้การทำงานที่เรียกกว่า Four-Point Editing
ซึ่งหมายถึงการตัดต่อที่ต้องมีการกำหนดจุดขึ้นมา 4 จุด ในที่นี้ก็คือ จุด In/Out บนคลิป
และ จุด In/Out บนไทม์ไลน์ แล้วใช้คำสั่ง Insert to Timeline หรือ Overwrite to Timeline
เพื่อนำคลิปนั้นวางลงไประหว่างช่อง In/out ของไทม์ไลน์ ถ้าคลิปนั้นยาวเกินช่องว่าง EDIUS
จะปรับให้อัตราเร็วของคลิปเป็นแบบเล่นเร็ว (คลิปสั้นลง) ในทางกลับกัน
ถ้าคลิปนั้นสั้นกว่าช่องว่าง EDIUS ก็จะปรับอัตราเร็วของคลิปเป็นแบบเล่นช้า
(คลิปยาวขึ้น) ให้พอดีกับช่องว่างนั้น 

วิธีทำ Four-Point Editing 
1. ดับเบิลคลิกคลิปที่ต้องการใช้งานบนหน้าต่าง Bin เพื่อส่งคลิปไปสู่จอ Player 
2. คลิกหน้าต่าง Player แล้วกำหนดจุด In/Out (กดปุ่ม I และ O บนแป้นพิมพ์)
ของคลิปที่ต้องการใช้งาน   
3. คลิกหน้าต่าง Timeline แล้วกำหนดจุด In/Out (กดปุ่ม I และ O บนแป้นพิมพ์)
ที่ต้องการวางคลิปบนไทม์ไลน์ 
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4. กำหนดลู่เป้าหมายโดยการคลิกเลื่อน Track Patch (V และ/หรือ A ที่หัวลู่) แล้วคลิกที่ปุ่ม
Insert to Timeline หรือ Overwrite to Timeline ในจอ Player ขึ้นอยู่กับการใช้งาน หรือจะใช้ปุ่ม ""
บนแป้นพิมพ์แทนก็สะดวกดี

============================================================================

Re:EDIUS 6.5 Tricks
Posted by suchart - 2014/05/29 09:33
_____________________________________

วิธีทำให้โปรเจ็กต์สเตอริโอ กลายเป็นโมโน หรือเสียงเหมือนกันทั้งสองข้าง 

ถามกันมาเป็นประจำเรื่องการทำเสียงสเตอริโอให้มารวมกันเป็นโมโนเหมือนกันทั้งสองข้าง
หรือแม้แต่การนำไปรวมไว้ข้างใดข้างหนึ่งเพื่อจะนำข้างที่เหลือไปใช้งานอื่น
เช่นทำเป็นเสียงพากษ์หรือเสียงร้องคาราโอเกะเป็นต้น
วิธีการที่จะพูดถึงต่อไปนี้ให้ท่านสามารถประยุกต์เอาไปจัดการกับเสียงต่าง ๆ
ไม่ว่าจะเป็นโมโน สเตอริโอ หรือแม้แต่เสียงแบบหลายช่องเช่นเสียงรอบทิศก็ได้ 

ไปที่เมนู Settings เลือก Sequence Settings.. (จะไปเซ็ตที่ Project Setting.. ก็ได้
แต่ขั้นตอนจะเยอะกว่า) 
จะปรากฏหน้าต่างสนทนาข้างล่าง 

http://www.dvm-mag.com/images/forum/ChannelMap3.JPG 

เลือก Channel map … จะปรากฎหน้าต่าง Audio channel map 

http://www.dvm-mag.com/images/forum/ChannelMap2.JPG 

คลิกปุ่ม Change Display Style มุมล่างซ้าย
http://www.dvm-mag.com/images/forum/ChannelMap4.JPG เพื่อใช้ map แบบเวอร์ชันเก่าดังรูป 

http://www.dvm-mag.com/images/forum/ChannelMap5.JPG 

จะเห็นว่า แทร็ก 1VA  หรือแทร็กซ้าย ไปออกเอาต์พุตช่อง Ch1 อย่างเดียว แทร็ก 1VA 
หรือแทร็กขวา ไปออกเอาต์พุตช่อง Ch2 อย่างเดียว เช่นเดียวกับแทร็กอื่น ๆ
ซึ่งแยกซ้ายขวาหรือเป็นสเตอริโอนั่นเอง 
ให้ทำการคลิกให้แต่ละแทร็กไปออกทั้ง Ch1 และ  Ch2 ดังรูปต่อไป
ทุกแทร็กก็จะไปออกทั้งสองช่องเหมือนกันหมด 

http://www.dvm-mag.com/images/forum/ChannelMap6.JPG 

เมื่อกลับไปดูหน้า map เดิม (คลิกที่ปุ่ม Change Display Style อีกครั้ง) จะเห็นเป็นดังนี้ 

http://www.dvm-mag.com/images/forum/ChannelMap7.JPG 

แสดงว่า แต่ละแทร็กจะถูกส่งออกไปทั้งช่องซ้ายและช่องขวาเหมือนกัน
เพียงแต่ว่าเราไม่สามารถเซ็ตแบบนี้ได้ในหน้าจอ map แบบใหม่เท่านั้น 

เราสามารถ Save การตั้ง Audio channel map นี้ไว้ได้เพื่อใช้ในครั้งต่อ ๆ
ไปโดยการคลิกที่ปุ่ม Preset (อยู่ทางขวาของปุ่ม Change Display Style) จะมีทางเลือกให้ Save,
Load, และ Properties.. 
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เท่านี้ ท่านก็สามารถจัดการกับเสียงซ้ายขวา การสลับช่องซ้ายขวา
การดึงช่องเสียงที่อาจไม่ได้ยินเสียงเมื่อไปบันทึกอยู่ในแทร็ก 3/4 หรือสูงกว่า เป็นต้น

============================================================================
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